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. Podstawy programowania w jezyku F#
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1.1 Programowanie funkcyjne

Programowanie funkcyjne, jak zreszta nazwa na to wskazuje, polega przede wszystkim
na pisaniu programoéw, ktére za pomoca ciagu wywotan funkcji przetwarzaja dane w celu

uzyskania rezultatu, ktéry mozna przedstawi¢ uzytkownikowi.

p) Krétkie przypomnienie informacji o funkcjach

Definicja 1.1.1 Niech dane beda dwa dowolne zbiory A i B. Funkcja f, czyli
odwzorowaniem zbioru A w B nazywa sig¢ relacje binarna f C A x B, ktéra kaz-
demu elementowi ze zbioru A przyporzadkowuje co najwyzej jeden element ze
bioru B, tzn. jezelia € Aib € B,to < a,b >€ f.

Element a nazywany jest argumentem funkcji, a element b wartoScia funkcji f dla
argumentu a.

Graficznie funkcj¢ mozna przedstawic¢ za pomoca ponizszego diagramu:

Zwréémy uwage, ze zbiory A i B sag dowolnymi zbiorami, co oznacza, ze ich ele-
mentami moga by¢ nie tylko liczby, ale réwniez bardziej ztozone struktury jak pary,
rekordy, tablice, zbiory, a nawet inne funkcje.

Funkcje mozna zapisaé w postaci:

f:A—=B
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gdzie f okresla nazwe, a wyrazenie A — B typ funkcji. Sygnatury funkcji sa bardzo
przydatne podczas analizy programéw, a zwlaszcza programéw funkcyjnych.
Oczywiscie funkcje moga mie¢ wigcej niz jeden argument. Méwimy wtedy o funk-
cjach wieloargumentowych. Ich sygnature funkcji zapisuje si¢ nastgpujaco:

f:A XAy x---xA, —B

Bardzo istotnym wnioskiem wynikajacym z powyzszej definicji jest fakt, ze warto$¢
funkcji matematycznej zalezy wytacznie od jej parametréw wejSciowych.
Teoretyczne rozwazania na temat funkcji bedziemy kontynuowaé réwniez w dalszych
czgsciach tego opracowania.

Kto§ mégltby powiedziec, ze przeciez funkcje mozna tworzy¢ w dowolnym jezyku
programowania, wigc po co wymyslac¢ osobne jezyki programowania, ktére opieraja si¢ na
funkcjach. Owszem, ale czy funkcje pisane w jezykach takich jak C++ sa funkcjami w
sensie matematycznym?

Przyjrzyjmy si¢ nastepujacemu programowi:

int ¢ = 0;

int funkcja(int a, int b)
{

c = at+b+c;

return c;

3

Zawiera on prosta funkcje, ktéra sumuje warto$ci swoich parametréw i do wyniku tej
operacji, dodaje jeszcze warto$¢ zmiennej globalnej c. Wynik tego dodawania zapisuje w
tej samej zmiennej ¢ oraz zwraca jako swoj rezultat.

Przyjrzyjmy si¢ teraz wywotaniu tej funkc;ji:

cout <<funkcja(1l,2)<<endl;
cout <<funkcja(1l,2)<<endl;
cout <<funkcja(1l,2)<<endl;

W rezultacie dziatania tego programu na ekranie otrzymamy nastgpujace wartosci:

3
6
9

Zwroémy uwage, ze za kazdym razem gdy wywotamy te funkcje z tymi samymi
argumentami uzyskujemy inng wartoS¢. Moze to wskazywac, ze funkcja ta ma pewien
ukryty parametr wejSciowy, ktéry nie jest zdefiniowany. Tym parametrem jest tzw. stan, w
ktérym funkcja ta jest wywotywana. NajproSciej mozna stan przedstawic jako wszystkie
elementy zewnetrzne (w tym pamigé, sprzet, sie€ internet), ktére maja wptyw na sposéb
dziatania funkcji. Stan ten moze ulega¢ modyfikacjom. Jezeli zmiany stanu odbywaja
si¢ wewnatrz funkcji, mozemy powiedzie¢, ze funkcja ta posiada efekt uboczny (w tym
przypadku polegajacy na wprowadzeniu nowej wartosci do tego samego obszaru pamigci —
czyli wykonaniu operacji przypisania).

Czy wobec tego modyfikowalny stan utatwi nam analiz¢ programéw, czy ja utrudni?
OczywiScie utrudni. Jest to spowodowane tym, ze nie mozemy powiedziec, jaki bedzie
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doktadny rezultat dziatania funkcji, patrzac na sama funkcje. Musimy jeszcze znaé stan w
jakim ta funkcja bedzie wywotana.

Powiecie teraz, ze przeciez i tak nie korzystacie ze zmiennych globalnych, bo nie jest
to dobry styl programowania, albo programujecie obiektowo w takich jezykach jak JAVA
czy C#, gdzie nie mozna deklarowaé zmiennych poza klasa czy funkcja. Oczywiscie macie
racje, ale modyfikacje sktadowych klasy, w sposdb ktére nie jest jawnie okre§lony w pro-
gramie réwniez utrudnia nam analiz¢ programu, a takze tworzenie testow jednostkowych,
czy aplikacji réwnolegtych lub asynchronicznych.

Juz sam fakt istnienia pewnego elementu, ktéry moze wptynaé niejawnie na sposob
dziatania funkcji powoduje, ze funkcje tworzone w jezykach imperatywnych nie sa funk-
cjami w sensie matematycznym. Jednak istnienie modyfikowalnego stanu moze réwniez
spowodowac, ze funkcje nie beda podlegaty podstawowym prawom matematyki.

Przeanalizujmy nastgpujacy program:

#include <iostream>
using namespace std;

int f(int a, int b) {
return a+b;

}

int g(int a, int b) {
return a*b;

¥

int main ()

{
cout<<"f(1,2),+,g(3,4) ,=,"<<f(1,2)+g(3,4)<<endl;
cout<<"g(3,4) ,+,f(1,2),=,"<<g(3,4)+f(1,2)<<endl;
return O0;

}

W tym przypadku, na ekranie zobaczymy:

15
15

£(1,2) + g(3,4)
g(3,4) + £(1,2)

OczywiScie jest to w stu procentach zgodne z nasza intuicja, bo w koncu od szkoty
podstawowej nauczyciele matematyki ucza nas ze dodawanie jest przemienne, czyli a+b =
b+ a. Co si¢ jednak stanie jezeli do powyzszego programu wprowadzimy modyfikowalny
stan? Przyktadowo zmiefimy ten program w nastgpujacy sposéb:

#include <iostream>

using namespace std;

int ¢ = 1;

int £f(int a, int b) {
c = a+b;

return a+b;

}
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int g(int a, int b) {
return a*bx*c;

}

int main () {
cout<<"f(1,2),+,g(3,4) =,"<<f(1,2)+g(3,4)<<endl;
return O;

}

Po jego uruchomieniu uzyskamy wartosé: 39. Jezeli jednak zamienimy linijke na

cout<<"g(3,4) ,+,f(1,2),=,"<<g(3,4)+f(1,2)<<endl;

to wynik bedzie wynosi znowu 15.

Przyktad ten pokazuje, ze istnienie w aplikacji modyfikowalnego stanu powoduje,
ze kolejnos¢ wykonywanych dziatan wplywa na ostateczny rezultat naszego programu i
ma bardzo duze znaczenie podczas jego analizy. Potwierdza to twierdzenie, ze funkcje
tworzone w jezykach imperatywnych, moga nie by¢ funkcjami w sensie matematycznym.

Jezyki funkcyjne staraja si¢ ogranicza¢ wplyw stanu aplikacji na dziatanie funkcji.
Znaczaco utatwia to analiz¢ programu, gdyz wystarczy popatrze¢ na funkcje (nawet w ode-
rwaniu od reszty aplikacji) i mozemy powiedzieé, co ta funkcja robi i w jakich sytuacjach
dziata dobrze, a w jakich bedzie dzialala btgdnie. Umozliwia to wykorzystanie wielu
ciekawych technik programistycznych, ktére sa doceniane réwniez przez spotecznosci
programujace imperatywnie, a w szczegdlnosci obiektowo (i spowodowato wprowadzenie
cech funkcyjnych do jezykéw takich jak JAVA, C# czy C++).

Wprowadzenie do jezyka F#

Jezyk F# jest nowoczesnym jezykiem funkcyjnym pozwalajacym na tworzenie aplikacji
dla platformy .NET. Jest to jezyk typu "Functional First". Oznacza to, ze wspiera on
przede wszystkim paradygmat programowania funkcyjnego. Pozwala jednak na tworzenie
oprogramowania réwniez w stylu imperatywnym i obiektowym, cho¢ w ramach tych zajec
nie bedziemy zaglebiac si¢ w tych cechach tego jezyka.

Cho¢ jezyk ten nie jest jeszcze tak szeroko stosowany jak inne gtéwne jezyki plat-
formy .NET - C# lub Visual Basic, to mozemy w nim tworzy¢ dowolny rodzaj aplikacji
(konsolowe, okienkowe, internetowe, czy inne).

W kolejnych punktach przyjrzymy si¢ podstawowym elementom jezyka F# , a nastgpnie
zobaczymy jak mozemy tworzy¢ i uruchamia¢ — w réznych sSrodowiskach — aplikacje
stworzone za jego pomoca.

Deklarowanie zmiennych

Nowe zmienne sa deklarowane za pomoca stowa kluczowego let:

Ilet x = 3+4

Powyzsza instrukcja powoduje wyznaczenie warto$ci wyrazenia znajdujacego si¢ po
prawej stronie znaku roéwnosci i powigzanie wyniku z nazwa x. W interpreterze zobaczymy
nastgpujacy rezultat:
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1.4 Proste typy danych w F# %

Ivalx:int=7

Oznacza to oczywiscie, ze utworzyliSmy wartos$¢ catkowita 7 (typ int), ktéra bedzie
powiazana z symbolem x.

Domyslnie jezyk F# traktuje pamigC jako obszar jednokrotnego zapisu. Oznacza to, ze
pamigé (w tym przypadku warto$§¢ zmiennej) mozna ustawié tylko podczas deklaracji i
p6Zniej nie mozna jej juz zmieni¢ !, tylko zwolni¢ do ponownego wykorzystania. Dlatego
mozna powiedzie¢, ze wykorzystanie okreSlania zmienna jest w tym przypadku lekkim
naduzyciem, w koncu symbol x nie okresla zmiennej w sensie innych (imperatywnych)
jezykéw programowania. Lepszym i chyba bardziej poprawnym okreSleniem byloby
etykieta dla wartoSci, ale poniewaz w innych materiatach jakie mozecie odnaleZ¢ na tego
jezyka najczeSciej korzysta si¢ jednak z terminu Zmienna", wigc my réwniez pozostaniemy
przy tej nazwie.

Proste typy danych w F#

Zwr6¢my uwage, ze podczas deklaracji zmiennej x nie okreSliliSmy jej typu. Choé
jezyk F# jest jezykiem SciSle typowanym, tzn. kazdy deklarowany symbol musi mie¢
przypisany typ, ktéry péZniej nie moze by¢ zmieniony, nie ma potrzeby, aby recznie
okreslaé typ kazdej zmiennej (jak réwniez parametru funkcji — co zobaczymy pdézZniej).
Jest to mozliwe poniewaz, interpreter i kompilator F# maja wbudowany bardzo rozwinigty
system wnioskowania typu. Mechanizm ten jest bardzo rozbudowany i sprawdza si¢ w
wigkszoSci przypadkéw, czasami musimy jednak wspomdc go poprzez reczne okreslenie
typu zmiennej. Mozemy to zrobi¢ podajac po nazwie zmiennej dwukropek oraz nazwe

typu:

I let x:int = 12

Poniewaz F# jest jezykiem, ktéry kompiluje si¢ do platformy .NET, tworzac w nim
programy mamy dostep do wszystkich typdw, ktére sa na niej zdefiniowane. Podobnie
operacje jakie mozemy na nich wykonywaé. Sa jednak niewielkie r6znice w nazewnic-
twie np. typ liczb zmiennoprzecinkowych podwdjnej precyzji, ktéry w C# nazywa sig
double, w F# okre§lany jest jako float 2. F# jest wyposazony w standardowy zestaw
operatoréw matematycznych, relacyjnych oraz logicznych. Mitym dodatkiem jest ope-
rator ** stuzacy jako operacja potggowania, czyli operacje x’ mozemy zapisaé w formie
xxxy. W jezyku tym podstawowe funkcje arytmetyczne tj. np. sin, cos, abs, min, max,
log, log10, round, floor, ceil, sqrt i inne. Pelng list¢ operatoréw F# mozna znalez¢ pod
adresem: https://fsharp.github.io/fsharp-core-docs/reference/fsharp-core-operators.html.
OczywiScie mozemy rowniez korzysta¢ z wszystkich funkcji 1 wartoSci zdefiniowanych w
klasie System.Math.

Obstuga tancuchéw znakéw w F#

Lanicuchy znakéw zapisujemy w cudzystowach:

Tezyk F# nie jest jezykiem czysto funkcyjnym wigc umozliwia tworzenie kodu wykorzystujacego efekty
uboczne — migdzy innymi umozliwiajace modyfikowanie wartosci zmiennych — ale jak juz wspominatem,
nie bedzie to celem tych zajeé

’Dostepna jest réwniez nazwa double lecz jest ona zdecydowanie rzadziej wykorzystywana
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I let tekst = "Ala ma kota"

Instrukcja ta spowoduje utworzenie niemutowalnego obiektu klasy String. Poniewaz jest
to petnoprawny obiekt, zawiera on wlaSciwosci i metody, ktére stuza do wykonywania
operacji na tym taricuchu znakéw. Przyktadowo, jezeli bedziemy chcieli okresli¢ dtugos¢
tego tancucha, mozemy to zrobi¢ w nastgpujacy sposob:

I tekst.Length

Podobnie bedziemy postgpowali, w przypadku gdy bedziemy chcieli wywotaé jakas metode
dziatajacq na stringach np. przy wycinaniu jego fragmentu:

I tekst.Substring(4,2)

Powyzsza instrukcja zwréci nam nowy tancuch znakéw "ma". Lancuchy znakow sa
indeksowane od zera. Opis wszystkich dostgpnych funkcji mozemy odnaleZ¢ pod adresem:
https://docs.microsoft.com/pl-pl/dotnet/api/system.string ?view=net-5.0#properties.

W F# istnieja trzy uzyteczne operatory umozliwiajace prace na stringach ’+’ stuzacy
do taczenia dwdch tancuchéw znakow, [] - umozliwiajacy dostep do pojedynczego znaku
oraz [..] - wycinajacy fragment. Przyktadowo, jezeli bedziemy chcieli pobrac pierwszy
znak z faicucha mozemy to zrobié nastgpujaco:

I tekst. [0]
Z kolei zapis

| tekst.[4..5]

da identyczny rezultat jak wczesniej pokazywane wywotanie funkcji Substring, przy
czym w przypadku funkcji podawaliSmy indeks pierwszego znaku, od ktérego chcieliSmy
skopiowa¢ fragment oraz liczbe znakéw do skopiowania, a w przypadku operatora [..]
podajemy indeksy pierwszego i ostatniego znaku do skopiowania.

Bardzo ciekawym rozwiazaniem, sa interpolowane fancuchy znakéw zaimplemento-
wane w F# . Zal6zmy, ze dokonujemy jakichs obliczen 1 wyniki chcielibySmy wyswietli¢
na ekranie. Mozemy to zrobi¢ np. w nastgpujacy sposob:

let x = 12.0

let wynik = sin x

System.Console.WriteLine("Wartoscia funkcji sin dla argumentu "
+x.ToString()+" jest "+wynik.ToString())

Jak widzimy przygotowanie odpowiedniego komunikatu nie jest zbyt przyjemne. Po
pierwsze nalezy wykonaé faczenie wielu tancuchéw znakéw. Po drugie nazwy x i wynik
sq przypisane do wartosci typu float, wigc aby operator *+’ mdgt poprawnie dziataé, nalezy
je zamieni¢ na tancuchy znakéw, co robimy za pomocg metod ToString().

Dzigki tancuchom interpolowanym mozemy to samo zapisaC prosciej:

let x = 12.0

let wynik = sin x

System.Console.WriteLine ($"Wartoscia funkcji sin dla argumentu <
{x} jest {wynik}")
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Larcuch interpolowany rozpoczynamy od znaku $ i wewnatrz niego w nawiasach { }
podajemy wyrazenie, ktérego warto$¢ ma by¢ obliczona 1 wstawiona do tancucha w jego
miejsce.

Konwersja typow w F#

Podczas tworzenia aplikacji w F# nalezy pamigtac, ze jezyk ten, w przeciwienistwie do
innych jezykéw programowania, nie wspiera niejawnych konwersji wobec tego typ
wartosci oraz typ przypisany nazwy muszg by¢ zgodne. Wykonanie ponizszej instrukcji

I let x:float = 12

Zakonczy si¢ zwréceniem komunikatu o bledzie:

error FSO001: This expression was expected to have type ’float’” but here has type ’int’.

Nie ma réwniez mozliwo$ci wykonywania operacji na wartosciach réznych typéw.
Przyktadowo ponizsza instrukcja, ktéra w innych jezykach programowania wykona si¢
bez problemu, tutaj spowoduje wySwietlenie komunikatu o btedzie.

flet x =12.0 +3

Aby powyzsza instrukcja byta poprawna, nalezy dokonaé jawnej konwersji typu, ktérej
dokonujemy — w przypadku typéw prostych — za pomoca funkcji o takiej samej nazwie jak
typ docelowy:

 let x = 12.0 + (float 3)

Funkcje te pozwalaja réwniez na konwersj¢ tancuchéw znakéw na okreslony typ np:

| let x = 12.0 + (float "3")

Musimy przy tym pamigtac, ze jezeli tancuch znakéw nie bedzie zawierat poprawne;j
liczby, to rzucony zostanie wyjatek.

Wyrazenia

Kazda instrukcja w jezyku F# jest wyrazeniem, ktére zwraca warto$¢. Oczywiscie jak
w kazdym jezyku, mozemy deklarowaé wyrazenia arytmetyczne, bitowe, relacyjne oraz
inne. Moga si¢ one sktada¢ z zmiennych, wartosci statych, wywotan funkcji potaczonych
za pomocg odpowiednich operatoréw. Poniewaz sg one w wigkszosci takie same jak w
innych jezykach (np. C++ czy C#) nie bede ich tutaj szczegdtowo rozpisywal. Nalezy
zwrdécié jednak uwage na operatory réwnosci i nieréwnoSci oraz negacji logicznej, ktére
sa zdefiniowane odpowiednio za pomocg symboli "=", «>6raz fiot".

Do bardziej rozbudowanych wyrazen nalezy wyrazenie warunkowe, ktére w F# przyj-

muje postaé:

if warunek then
wyrazenie_prawda

else
wyrazenie_falsz
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Wyrazenie warunek musi zwracaé warto$¢ logiczna (typu bool). Do jego zdefiniowa-
nia mozna wykorzysta¢ operatory logiczne: true (prawda), false (fatsz), Il (logiczne lub),
&& (logiczne 1), not (negacja) oraz operatory relacyjne: >,<,<=>=,<>=.

Zwroccie uwage, ze cho¢ sktadania tego wyrazenia jest podobna do instrukcji warun-
kowej istniejacej w innych jezykach programowania, méwimy tutaj o wyrazeniu. Oznacza
to, ze zwraca ono wartos¢, ktéra moze by¢ wykorzystana do dalszych obliczen, a samo
wyrazenie moze by¢ czescia wigkszej konstrukeji np:

let x = 13
let wynik = 20 + if x > 12 then 10 else O

Poniewaz instrukcja warunkowa jest wyrazeniem, z obu swoich czgSci musi ona
zwracac warto$¢, a ponadto wartoSci te musza by¢ tego samego typu.

p ) Jak wspomniano, wszystkie instrukcje, jako wyrazenia, musza mie¢ okreSlony typ
danych i zwraca¢ wartoS¢. Sg jednak instrukcje, w ktérych nie mozna jawnie
okresli¢ wartos$ci zwracanej. Przyktadem takiej instrukcji jest chociazby polece-
nie printfn, ktére jest odpowiedzialne za wySwietlenie komunikatu w konsoli. W
takim przypadku wyrazenie to zwraca warto$¢ specjalnego typu o nazwie Unit. Typ
ten ma tylko jedng warto$¢ oznaczang jako ().

Mozliwe jest rowniez wykorzystanie wyrazenia warunkowego tylko z okreslonym
warazeniem_prawda, ale w tym przypadku wyrazenie to musi zwracaé warto$¢ typu Unit.

Deklarowanie funkcji
W F# funkcje mozemy deklarowac za pomocg wyrazenia funkcyjnego, ktére przyjmuje
postac:

I fun <lista parametrow> -> <cialo funkcji>

Przyktadowo wydanie nastgpujacego polecenia:

I fun x —> x+1

zakonczy sig¢ uzyskaniem nastgpujacego wyniku:

I val it : x:int -> int

Zwréémy tutaj uwage na kilka rzeczy. Po pierwsze nie podaliSmy nazwy funkcji (utwo-
rzyliSmy funkcje anonimowa, dlatego interpreter okreslit ja jako wartoS¢ o nieokreslone;j
nazwie it). Po drugie cho¢ nie podaliSmy typéw zmiennych ani rezultatu funkcji inter-
preter poprawnie rozpoznat je jako int - dlaczego?. Po trzecie i najwazniejsze interpreter
okreslit rezultat dziatania instrukcji jako val, czyli wartoS¢.

W jezykach funkcyjnych, funkcje traktowane sa jako ébywatele"pierwszej klasy, co
oznacza, ze mozna je traktowac jak kazda inng warto$¢. Powoduje to, ze funkcj¢ podobnie
jak np. liczbe catkowita, mozemy powiazac z etykieta za pomoca instrukcji let:

I let inkrementuj = fun x -> x+1

w tym przypadku w interpreterze zobaczymy:
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Ival inkrementuj : x:int -> int

Zwréémy uwage na rezultat powyzszych fragmentéw kodu. Zauwazmy, ze to co
wystepuje po stowie val jest niczym innym jak wspomniang wcze$niej sygnaturg funkcji
(jej zapis jest zgodny z notacja matematyczna, przy czym notacja F# dotacza jeszcze nazwy
parametréw funkcji).

Oczywiscie mozemy deklarowac réwniez funkcje wielu parametréw. Zapisujemy je w
nastepujacy sposob:

I let dodaj = fun a b -> a+b

Powyzsza instrukcja do nazwy dodaj przypisze funkcje anonimowg o dwdch parame-
trach aib. Zwré¢my uwage, ze listy parametréw nie musimy ujmowaé w nawiasy okragte
i nie mozemy rozdziela¢ ich przecinkami. Do rozdzielania parametréw wykorzystuje si¢
biate znaki (spacja lub tabulacja).

W powyzszej instrukcji zobaczymy

Ival dodaj : a:int -> b:int -> int

Ta dziwna sygnatura wyjasni si¢ w dalszej czeSci tego opracowania, gdy bedziemy
szczeg6towo omawiali jak F# traktuje funkcje wielu zmiennych.

Poniewaz funkcje sa najczesciej deklarowana jednostka jezyka F# mozna skorzystac z
troche uproszczonej sktadni:

I let dodaj a b = atb

w ktorej po stowie kluczowym let podajemy nazwe funkcji, a nastgpnie jej parametry
(oddzielajac je oczywiscie za pomoca biatych znakéw). Nastgpnie podajemy znak réwnosci
1 wyrazenie, ktére stanowi ciato funkcji.

Bez wzgledu na sposéb deklaracji, utworzona funkcje mozemy wykorzysta¢ do wyzna-
czenia jej wartoSci:

I let wynik = dodaj 12 34

Jak widzimy, wywotanie funkcji (lub jak okresla si¢ to w jezykach funkcyjnych
zaaplikowanie funkcji do prametréw) dokonuje si¢ poprzez podanie jej nazwy oraz listy
wymaganych atrybutéw. Wyrazenia wyznaczajace wartoSci poszczegdlnych argumentow
oddzielamy od siebie biatymi znakami. Jezeli wyrazenie okreslajace wartosS¢ atrybutu nie
jest odwotaniem do etykiety lub nie jest to wartoS¢ stata, to takie wyrazenie nalezy wzia¢
W nawiasy np:

dodaj (12+34) 56
dodaj (dodaj 12 34) 56

let wynikl
let wynik2

p ) Jezeli cheielibySmy zadeklarowac funkcje nie przyjmujacg parametréw lub nie zwra-
cajacg wyniku nalezy wykorzysta¢ typ Unit. Przyktadowo ponizsza funkcja nieprzyj-
muje zadnego parametru i zawsze zwroci warto$¢ 1:

I let zawszel () =1
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Podobnie jak przy deklarowaniu innych wartosci, przy tworzeniu funkcji nie musimy
jawnie okresSlaé typu jej parametrow oraz typu wartosci zwracanej. Czasami jednak jest to
konieczne. Mozemy to wtedy zrobi¢ w nastgpujacy sposob:

I let dodaj (a:float) (b:float) : float = atb

W tym przypadku typ podany pomigdzy znakami ’:’ oraz ’=" oznacza typ wyniku funkcji.
Jako ciato funkcji mozemy wykorzysta¢ dowolne wyrazenie, rowniez takie ktére bedzie
zawierato wiele linii kodu np.

let przyklad x =
if x<0 then
printfn "wartosc parametru jest ujemna"
else
printfn "wartosc parametru jest nieujemna"

W powyzszym przykladzie nalezy zwrécié szczegdlng uwage na zastosowane wcigcia
kodu. W przeciwieristwie do innych jezykdéw, ktérych sktadania oparta jest na sktadni C++
lub Pascal gdzie blok kodu oznacza si¢ odpowiednio symbolami {} lub begin end, w F#
blok kodu okresla si¢ za pomoca wcig€. Kazda linijka kodu, ktéra ma naleze¢ do tego
samego bloku musi rozpoczynac si¢ w tej samej kolumnie. Jezeli chcemy zdefiniowac blok
zagniezdzony w innym bloku musi on by¢ bardziej wcigty niz blok nadrzedny (przy czym
liczba spacji nie ma znaczenia). Jezeli powyzszy program zapisaliby$my, tak aby wszystkie
jego linie rozpoczynaty si¢ w tej samej kolumnie, to w najlepszym przypadku uzyskamy
ostrzezenie, a w najgorszym oczywiscie nasz program nie bedzie dziatat poprawnie.

Wewnatrz bloku kodu mozemy deklarowa¢ zmienne lokalne, ktére beda widoczne
tylko wewnatrz niego. Robimy to réwniez za pomoca instrukcji let:

let przykladl x =

let y = 12

if x > 0 then
let z = 12
X+y+z

else
let z = 34
X+y+z

W przypadku funkcji instrukcja let jest wyrazeniem, czyli musi zawieraC wyrazenie
okreslajace jej warto$€. Dlatego ponizsza funkcja jest btedna (wyrazenie 1et nie ma ciata):

let przykladl x =
let y = 12

Musimy pamigtaé, ze blok kodu okresla zakres widocznosci zmiennej. Z tego powodu
ponizsza funkcja rowniez bedzie btgdna (w linii 10 zmienna z jest zapisana poza zakresem
swojej widocznosci)

let przyklad2 x =
let y = 12
let w =
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if x > 0 then
let z = 12
xty+z

else
let z = 34
X+y+z

Rekurencija

Poniewaz w programowaniu funkcyjnym staramy si¢ unikaé¢ zmiany stanu (nawet lokal-
nego), dlatego nie powinniSmy korzystaé z instrukcji typowo imperatywnych. Jedng z
nich jest petla (w dowolnym rodzaju) 3. Wobec tego jedynym sposobem, aby w jezykach
funkcyjnych #, wielokrotnie wywotaé ten sam kod jest wykorzystanie funkcji rekurencyj-
nych, czyli takich, ktére wywotuja same siebie. W przypadku jezyka F# (jak réwniez w
przypadku innych jezykéw funkcyjnych), deklaracje rekurencyjne tworzymy za pomoca
specjalnej instrukcji 1et rec. Przyktadowo, ponizej mamy zadeklarowana typowa funkcje
rekurencyjng pozwalajaca wyznaczy¢ nam warto$¢ funkcji silnia dla zadanego argumentu:

let rec silnia x =
if x<0 then
failwith "nieprawidlowe dane wejsciowe"
elif x = 0 then
1
else
x*silnia (x-1)

Jest to typowy zapis funkcji silnia wynikajacy wprost z jej definicji matematycznej. Jak
mam nadziej¢ pamigtacie, w jezykach imperatywnych podczas wywotania funkcji na stosie
rezerwowana jest pamigé, dla tzw. ramki aktywacji. Zawiera ona wszystkie elementy
konieczne do uruchomienia funkcji, m.in. warto$ci zmiennych lokalny oraz parametry
funkcji i tzw. adres powrotu (miejsce w pamigci zawierajaca instrukcje, ktéra nalezy wy-
kona¢ jako nastgpna po zakonczeniu funkcji). Schematycznie ramke taka (w uproszczone;j
formie) mozna przedstawic jako:

Rysunek 1.1: Uproszczona struktura ramki aktywacji

37astanéweie si¢ dlaczego?
4Oczywiscie korzystajac z jezyk6w czysto funkeyjnych lub nie korzystajac z cech imperatywnych
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Oczywiscie, (prawie) kazde wywotanie funkcji tworzy swoja ramke aktywacji, ktéra
jest automatycznie usuwana z pamigci, gdy nastepuje powro6t z funkcji. Z tego powodu
wywolania funkcji okresla si¢ jako instrukcje cigzkie. Jest to szczegllnie widoczne
podczas uruchamiania funkcji rekurencyjnych. Ponizej schematycznie przedstawione
jest zaaplikowanie przedstawionej wczesniej funkcji silnia dla argumentu 4: Oczywiscie

456 — 24

3%x2 =6

2x1 =2

I«x1—1

pamigC przeznaczona na stos nie jest nieograniczona, dlatego dla im wigkszego argumentu
bedziemy chcieli policzyé warto$¢ funkc;ji silnia, tym wigcej bedzie wywotan funkcji i tym
wigcej pamigci na stosie bedziemy potrzebowac. Obliczenia bedziemy mogli prowadzi¢ do
momentu, gdy pamig¢ nam si¢ skonczy, a wtedy uzyskamy wyjatek Process is terminated
due to StackOverflowException.

Czy to oznacza, ze programy rekurencyjne, zwlaszcza te tworzone w jezykach funkcyj-
nych, musza by¢ nieefektywne? Niekoniecznie. Przyjzyjmy si¢ jaki kod jezyka posred-
niego jest generowany dla powyzszej funkcji:

method public static int32
silnia(
int32 x
) cil managed
{
.maxstack 5
.locals init (
[0] string V_O
)

IL_0000: 1ldarg.0 // x

IL_0001: 1dc.i4.0

IL_0002: bge.s IL_0006

IL_0004: br.s IL_0008

IL_0006: br.s IL_0015

IL_0008: 1ldstr "x nie moze byc mniejszy od zera"
IL_000d: stloc.O // V_O

IL_000e: 1dloc.O // V_O
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IL_000f: call class [mscorlib]System.Exception [FSharp.<—
Core]Microsoft.FSharp.Core.0Operators::Failure(string)
IL_0014: throw

IL_0015: ldarg.o0 // x

IL_0016: brtrue.s IL_001la
IL_0018: br.s IL_001c
IL_001la: br.s IL_001e

IL_001c: 1ldc.i4d.1

IL_001d: ret

IL_00le: ldarg.o0 // x
IL_001f: 1ldarg.o0 // x
IL_0020: 1ldc.i4.1

IL_0021: sub

IL_0022: call int32 Program::silnia(int32)
IL_0027: mul
IL_0028: ret

} // end of method Program::silmnia

OczywiScie nie interesuje nas catos$¢ tego kodu, a jedynie trzy ostanie linijki. Sa one
odpowiedzialne za rekurencyjne wywotanie funkcji silnia (IL_0022 call), wykonanie mno-
zenia wyniku tego wywotania przez warto$¢ parametru x (IL_0027 mul) oraz zakonczenie
funkcji i zwrdcenie do funkcji wywotujacej wartoSci znajdujacej si¢ na samej gorze stosu
(w tym przypadku jest to warto§¢ mnozenie z poprzedniej instrukcji) - IL_0028 ret. Czyli
w przypadku tego programu adresem powrotu ustawianym podczas rekurencyjnego wy-
wotania funkcji silnia bedzie adres linii IL_0027, poniewaz to jest nastgpna instrukcja do
wykonanie po zakoriczeniu wywolywania funkcji. Wtasnie ze wzgledu na wystepowanie
tej instrukcji konieczne jest tworzenie nowej ramki stosu podczas wywotania funkcji w
linii (IL_0022).

Napiszmy ten sam program, ale w trochg¢ inny sposéb:

let rec silnia (x:bigint) (a:bigint) =
if x<0I then
failwith "nieprawidlowe dane wejsciowe"
elif x = O0I then
a
else
silnia (x-1I) (x*a)

Zwr6¢my uwage, ze w tym przypadku funkcja zyskata dodatkowy parametr a. Zawiera on
czgSciowy wynik mnozenia wartos$ci wartosci funkcji, przez jej argument. Jest to pokazane
na schemacie 1.2. Poniewaz mnozenie wynik mnozenia jest teraz przekazywany jako
parametr do funkcji silnia samo mnozenie musi by¢ wykonane przed wywotaniem funkcji
(a nie po jak w przypadku wcze$niejszej wersji). Co nam to daje? Przyjrzyjmy si¢ znowu
wygenerowanym przez kompilator instrukcjom jezyka poSredniego.
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4x6 — 24

3x2—6

2x1 =2

I+x1—1

Rysunek 1.2: Wywotanie funkcji silnia z akumulatorem dla argumentu 4

.method private hidebysig static int32
SilnialAcc(

int32 x,

int32 n

) cil managed

{

.maxstack 3

.locals init (

[0] bool V_O,

[1] bool V_1,

[2] int32 V_2

)

IL_0000: nop

IL_0001: 1ldarg.0 // x
IL_0002: 1dc.i4.0

IL_0003: clt

IL_0005: stloc.O // V_O

IL_0006: 1ldloc.O // V_O

IL_0007: brfalse.s IL_0014

IL_0009: 1ldstr "x nie moze byc mniejszy od zera'

IL_00Oe: newobj instance void [System.Runtime]System.<—
Exception::.ctor(string)

IL_0013: throw

IL_0014: 1ldarg.0 // x

IL_0015: 1ldc.i4.0
IL_0016: ceq

IL_0018: stloc.1 // V_1
IL_0019: 1ldloc.t // V_1
IL_0Ola: brfalse.s IL_0020
IL_001c: 1ldarg.1 // n

IL_001d: stloc.2 // V_2
IL_001le: br.s IL_002e
IL_0020: 1ldarg.0 // x

IL_0021: 1dc.i4.1
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IL_0022: sub
IL_0023: 1ldarg.0 // %
IL_0024: 1ldarg.1 // n

IL_0025: mul

IL_0026: call int32 Test.Program::SilniaAcc(int32,int32)
IL_002b: stloc.2 // V_2
IL_002c: br.s IL_002e
IL_002e: 1ldloc.2 /] V_2

IL_002f: ret

} // end of method Program::Silnialcc

Znowu interesujace sa dla nas tylko wybrane instrukcje zaznaczone pogrubieniem. Zwréémy
uwage, ze w tym momencie instrukcja IL_0025 mul jest uruchamiana przed rekurencyjnym
wywolaniem funkcji silnia (linia IL_0026). Po tym wywotaniu funkcji nastepuje ciag
instrukcji:
1. IL_002b stloc.2 - zapisanie wyniku funkcji silnia (ktéry znajduje si¢ na szczycie
stosu) do drugiej zmiennej lokalnej i usunigcie go ze stosu.
2. IL_002c br.s IL_002e - wykonanie skoku bezwarunkowego do nastgpnej linii.
3. IL_002e ldloc.2 - odczytanie warto$ci drugiej zmiennej lokalnej i umieszczenie go
na szczycie stosu
4. IL_002f ret - zakonczenie funkcji i zwrécenie do funkcji wywolujacej wartoSci
znajdujacej si¢ na samej gérze stosu
Zwro¢my uwage, ze w tym przypadku wygenerowane przez kompilator jezyka C#
instrukcje, sa nadmiarowe i nie maja wigkszego sensu. Réwnie dobrze, bez wptywu na
sposéb dziatania funkcji trzy pierwsze z powyzszych czterech mozna wyrzucié, czyli
koncéwka powyzszego kodu wygladataby nastepujaco:
IL_0025: mul

IL_0026: call int32 Test.Program::SilnialAcc(int32,int32)
IL_002b: ret

} // end of method Program::Silmnialcc

Jak widzimy, po rekurencyjnym wywotaniu funkcji silnia nastepng instrukcja jest juz
tylko zakonczenie tej funkcji. Dlatego adres powrotu, wskazujacy na wnetrze funkcji
silnia jak réwniez wartoSci zmiennych lokalnych i parametréw nie sa nam juz dalej po-
trzebne. Mozemy je nadpisa¢ nowymi wartoSciami i dzigki czemu ponownie wykorzystaé
utworzona juz ramke aktywacji. Z tego powodu interpretery i kompilatory jezykow funk-
cyjnych pozwalaja generowanie efektywnego kodu jezyka maszynowego, ktére wszystkie
wywotania odpowiednio napisanych funkcji rekurencyjnych obstuzy¢ za pomoca jednej
funkcji aktywacji. Kompilator jezyka F# idzie nawet krok dale;j:

.method public static int32
silnia(
int32 x,
int32 n
) cil managed
{
.custom instance void [FSharp.Core]l]Microsoft.FSharp.Core—
.CompilationArgumentCountsAttribute::.ctor(int32([])
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= (01 00 02 00 00 00 01 00 OO0 OO 01 OO 00 00 00 00 ) // <
.maxstack b5

.locals init (

[0] string V_O

)

IL_0000: ldarg.O // x

IL_0001: 1dc.i4.0

IL_0002: bge.s IL_0006

IL_0004: br.s IL_0008

IL_0006: br.s IL_0015

IL_0008: 1ldstr "x nie moze byc mniejszy od zera"
IL_000d: stloc.0 // V_0

IL_000e: 1dloc.0 // V_O

IL_000f: call class [System.Runtime] System.—

Exception [FSharp.Core]Microsoft.FSharp.Core.—
Operators::Failure(string)
IL_0014: throw

IL_0015: 1ldarg.0 // x
IL_0016: brtrue.s IL_001la
IL_0018: br.s IL_001c
IL_001a: br.s IL_001le
IL_001c: ldarg.1 // n
IL_001d: ret

IL_0Ole: 1ldarg.O // x

IL_001f: 1dc.i4.1
IL_0020: sub

IL_0021: 1ldarg.0 // x
IL_0022: ldarg.1 // n
IL_0023: mul

IL_0024: starg.s n
IL_0026: starg.s X
IL_0028: br.s IL_0000

} // end of method Program::silnia

Zwréémy uwage, ze w tym przypadku nigdzie nie znajdziemy, instrukcji pozwalajacej
na rekurencyjne wywotanie funkcji Silnia. Jak w takim przypadku dziata nasza funkcja
rekurencyjna, skoro nie ma wywotania rekurencyjnego? Wszystko wyjasni si¢ jezeli na
podstawie kodu jezyka posredniego odtworzymy kod C#:

public static int silniaAcc(int x, int n)
{
int num;
for (; x >= 0; x = num)
{
if (x == 0)
return n;
num = x - 1;
n =X * n;
}
throw Operators.Failure("nieprawidlowe dane wejsciowe");

¥

Czyli nasza funkcja rekurencyjna zostata przez kompilator zamieniona na funkcje wy-
korzystujaca bardzo efektywna petle. A to wszystko dzigki wykorzystaniu rekurencji

3tak, oprogramowanie DotPeek réwniez to potrafi
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0ogonowe;j.

Jednostki miary

Jezyk F# zostal utworzony jako jezyk do analizy i przetwarzania danych. Jednak domyS$lny
zestaw typow numerycznych nie jest zbyt odpowiedni do tego typu zastosowan. Stworzmy
prosta funkcje:

I let predkosc (dystans:float) (czas:float) = dystans/czas

Funkcja ta ma obliczy¢ prgdkos¢ na podstawie przebytego dystansu oraz czasu w jakim to
nastapito, zaréwno dystans jak i czas zdefiniowane sa jako wartosci typu float.
Zdefiniujmy nastepnie kilka zmiennych:

let objetosc = 100.0
let odleglosc = 100.0
let czas = 1.0

1 wywotajmy nasza funkcje w celu wyznaczenia predkosci:

I let uzyskanaPredkosc = predkosc odleglosc czas

OczywiScie na pierwszy rzut oka, wszystko wydaje si¢ w porzadku, ale np. fizyk
zapytalby w tym momencie jakich jednostkach wyrazony jest dystans, czas i predkosc.
Mozemy powiedzieé, ze odlegtoS¢ wyrazona jest w kilometrach, czas w godzinach, no
a predkos¢ w kilometrach na godzing, ale z naszego programu to w zaden spos6b nie
wynika.

Co gorsza, poniewaz zarOwno parametry i zmienne sa zdefiniowane jak wartosci typu
float nic nie moze nas powstrzymac przez nastgpujacymi, nie majacymi wigkszego sensu,
wywotaniami funkcji:

predkosc czas odleglosc
predkosc objetosc czas

let uzyskanaPredkosc
let uzyskanaPredkosc

OczywiScie mozemy powiedzieC niech si¢ programista pilnuje, ale mimo wszystko nie
tego mozemy oczekiwaé od jezyka do przetwarzania danych.

Na szczeécie F# ma bardzo ciekawy mechanizm, pozwalajacy rozwigza¢ powyzsze pro-
blemy. Sa to jednostki miary. Pozwalaja one na zdefiniowanie nowego typu danych, ktéry
dodatkowo musimy opatrzy¢ atrybutem Measure. Przykladowo ponizszy kod definiuje
trzy jednostki miary: godziny, metry i kilometry:

[<Measure>] type h
[<Measure>] type m
[<Measure>] type km

Dzigki nim mozemy jawnie okresli¢, ze parametr dystans powinien by¢ liczba rzeczy-
wista wyrazajaca odlegtoS¢ w kilometrach, a parametr czas liczba rzeczywista wyrazajaca
czas w godzinach:

I let predkosc (dystans:float<km>) (czas:float<h>) = dystans/czas
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Dzigki temu wiemy w jakich jednostkach powinny by¢ podane poszczeg6lne parametry.
Ponadto F# jest w stanie okreSli¢ automatycznie w jakich jednostkach bedzie wyrazony
wynik dziatania funkcji:

I val predkosc : dystans:float<km> -> czas:float<h>-> float<km/h>

To powinno usatysfakcjonowac naszego fizyka, ale jak to wptynie na poprawnos¢
programu? Znaczaco ja poprawi, poniewaz teraz nie mozemy pod parametry funkcji
podstawi¢ zwyktych wartosci typu f1loat. Wykonanie kodu:

I predkosc odleglosc czas
zwrdci btad error FS0001: This expression was expected to have type *float<km>’ but
here has type float’, poniewaz wartoSci przekazane do funkcji musza by¢ wyrazone w
tych samych jednostkach co jej parametry. Wobec tego zmienne odlegtos¢ i czas powinny
by¢ teraz zdefiniowane jako:

let odleglosc = 100.0<km>
let czas = 1.0<h>

A co jezeli odlegto$¢ bedziemy mieli wyrazong dajmy na to w metrach? Powinni-
Smy napisa¢ funkcje konwertujaca. Aby to zrobi¢ musimy okresli¢ ile metréw mozemy
umiesci¢ w jednym kilometrze:

I let metryNaKilometr : float<m*km™-1> = 1000.0<m/km>

a nastgpnie wartos¢ tg¢ wykorzysta¢ do stworzenia funkcji zamieniajacej odlegtos¢ w
metrach na odlegtos¢ w kilometrach:

let konwertujMetryNaKilometry (odleglosc:float<m>) = odleglosc <=
/ metryNaKilometr

W powyzszym przykladzie nalezy zwréci¢ uwage na sposéb definiowania jednostek
wyrazonych za pomoca ilorazu. Mozemy to zrobi¢ albo bezposSrednio m/km, albo za
pomoca potegowania mxkm~-1. W tym drugim przypadku zamiast znaku ’*’ mozna
wykorzystac spacje.

Kilka przydatnych funkciji dostepnych w Fi#

Ponizej przedstawig¢ kilka przydanych instrukcji, ktére moga by¢ wam potrzebne przy
realizacji zadan przedstawionych w ostatniej czesci tej instrukcji:

1. open <nazwa modulu lub przestrzeni nazw> - otwiera modut lub przestrzen
nazw dzigki czemu nie bedziemy musieli odwotywaé si¢ do elementéw wewnatrz
niego za pomoca petnej nazwy. Przykladowo, jezeli bedziemy chcieli obliczy¢
obwdd kota, musimy skorzystac ze statej PI zdefiniowanej w klasie Math znajdujacej
si¢ w przestrzeni nazw System:

let promien = 12.0
let obwod = 2.0*System.Math.PI*promien
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Jezeli niewiele razy w aplikacji bedziemy si¢ odnosili do elementéw zdefiniowanych
w przestrzeni System, to taki zapis jest akceptowalny. Jednak, jezeli takich miejsc
bedzie duzo wygodniej bedzie nam zapisaé to w nastgpujacy sposob:

open System

let promien = 12.0
let obwod = 2.0*Math.PI*promien

2. Console.ReadLine() - metoda ta pozwoli nam wczyta¢ jedna lini¢ tekstu z konsoli.
Zwraca oczywiscie tancuch znakow. Klasa Console znajduje si¢ w przestrzeni nazw
System, wobec tego konieczne bedzie otwarcie tej przestrzeni lub podawanie petnej
nazwy.

3. Console.Write(<lancuch znakow>),Console.WritelLine(<lancuch znakow<—
>) - metody te pozwalaja na wySwietlenie wiadomosci w standardowym wyjSciu
(konsola lub interpreter). Metoda WriteLine dodatkowo przenosi kursor do nowej
linii.

4. printf,printfn - podobnie jak metody Console.Write oraz Console.WriteLine<—

metody te stuza do wysSwietlenia komunikatu na standardowym wyjsciu. Sg one
jednak wygodniejsze w uzyciu. Przyktadowo program:

let x = 12.0

let wynik = sin x

System.Console.WriteLine($"8aWartoci funkcji sin dla <«
argumentu {x} jest {wynikl}")

z wykorzystaniem funkcji printfn zapiszemy nastgpujaco:

let x = 12.0

let wynik = sin x

printfn "Wartoscia funkcji sin dla argumentu %f jest %f" x ¢«
wynik

Wartosci zmiennych x oraz wynik beda podstawione w miejsce "%f". Zapis "%f"
okresla typ i spos6b wySwietlenia wartosci i moze m.in. przyjmowaé jedng z
wartoSci:

Specyfikacja formatu typ

b bool

s string

e char

hd, hi int (jako wartosS¢ ze znakiem)
hu int (jako wartos$¢ bez znaku)
hx, hX int (jako wartos$¢ szesnastkowa)

Co ciekawe funkcje te pozwalaja sprawdzanie typéw danych np. jezeli zapiszemy:

I printfn "Wartosc %d" (sin 12.0)
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uzyskamy nastgpujacy komunikat o biedzie: error FSO001: The type *float’ is not
compatible with any of the types byte,int16,int32,int64,sbyte,uint16,uint32,uint64,
nativeint,unativeint, arising from the use of a printf-style format string

Funkcja printfn dodatkowo przenosi kursor do nowej linii.

5. sprintf - czasami zamiast wySwietla¢ komunikat w konsoli bedziemy chcieli go
zapisa¢ do zmiennej. Funkcja sprintf nam to umozliwia zwracajac odpowiednio
sformatowany tekst w formie tancucha znakéw. W inny wzgledzie dziata doktadnie
tak samo jak printf.

6. failwith - funkcja stuzaca do generowania wyjatku z komunikatem podanym jako
parametr.

7. Generowanie liczb losowych - aby skorzysta¢ w F# z generatora liczb losowych
nalezy najpierw stworzy¢ obiekt klasy Random, a nastgpnie wywotaé jedna z jego
metod Next (), Next (min, max) lub NextDouble(). Ta ostatnia pozwala na ge-
nerowanie wartosci z przedziatu 0,1. Przyktadowo, jezeli chcemy wygenerowac
wartoSci z przedziatu do 10 do 20 mozemy to zrobi¢ nastgpujaco:

let rand = new Random()
rand.Next (10, 21)

Tworzenie aplikacji w F#

W tej czgsci przedstawie wam podstawo narzedzia, w ktérych mozecie tworzy¢ aplikacje
w F# .

Visual Studio

Poniewaz F# jest dzietem firmy Microsoft podstawowym narzedziem, w ktéorym mozemy
tworzy¢ aplikacje w tym jezyku jest Srodowisko Visual Studio, aktulanie dostgpne w wersji
2019. Do naszych zaje¢ w zupetnosci wystarczy darmowa edycja Community.

W celu tworzenia nowego projektu, uruchamiamy Visual Studio, po czym powinni$Smy
zobaczy¢ nastgpujace okno:

Mozemy w nim stworzy¢ nowy projekt lub otworzy¢ juz istniejacy (wybierajac go
z dysku, lub listy ostatnio otwartych projektéw). Okno to mozemy réwniez otworzy¢
wybierajac opcje Project z menu File>New.

Poniewaz nie mamy jeszcze zadnego projektu — musimy utworzy¢ nowy, dlatego
wybieramy opcje¢ “Create a new project”. Spowoduje to wySwietlenie nastgpujacego okna
tworzenia nowego projektu:

Mozemy w nim wybraé jezyk, w ktérym chcemy tworzy¢ aplikacje oraz jej typ. W
przypadku aplikacji dla jezyka F# dostepne jest tworzenie m.in. aplikacji konsolowych
(Console Application), aplikacji internetowych (ASP.NET Core Web Application), biblio-
teki DLL (Class Library) oraz Tutorial. Ostatni z wymienionych jest prostym samouczkiem
pokazujacym najwazniejsze cechy jezyka F# . Zwr6¢my uwage, ze niektdre z tych szablo-
néw sa dostepne dla .NET Framework jak réwniez dla platformy .NET Core.

My wybierzemy szablon Console App (.NET Core) i przejdziemy do nastgpujacego
okna konfiguracji nowego projektu:

W oknie tym podajemy nazwe naszego projektu, katalog w ktérym ma on by¢ umiesz-
czony oraz nazwe tworzonego rozwigzania. W Visual Studio Rozwigzaniem nazywamy
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Visual Studio 2019

Open recent

As you use Visual Studio, any projects, folders, or files that you open will show up here for quick
access.

You can pin anything that you open frequently so that it's always at the top of the list.

&

Get started

¥
ca

it

Clone a repository
Get code from an online repository like GitHub
or Azure DevOps

Open a project or solution
Open a local Visual Studio project or sin file

Open a local folder
Navigate and edit code within any folder

Create a new project
Choose a project template with code scaffolding
1o get started

Continue without code -

Rysunek 1.3: Okno tworzenia nowego lub otwarcia istniejacego projektu Visual Studio

Create a new project

Recent project templates i

Alist of your recently accessed templates will be
displayed here.

All platforms

E‘-' Console App (NET Core)

Clear all

Al project types.

A project for creating a command-line application that can run on .NET Core on
Windows, Linux and MacOs.

F#  Windows

Linux

nﬁ" Class Library (NET Standard)
|

A project for creating a class library that targets NET Standard.

F#  Android

Linux

,q.'g ASPINET Core Web Application

DV project templates for creating ASP.NET Core web apps and web APIs for Windows,
Linux and macOS using .NET Core or NET Framework. Create web apps with Razor
Pages, MVC, or Single Page Apps (SPA) using Angular, React, or React + Redux.

B Linux

nﬁ" Class Library (.NET Core)
kL

macos.

macOS  Console

macoS  Windows Library

Windows ~ Web.

A project for creating a class library that targets NET Core.

Fé Linux

—F

macos.

Windows  Library

[ﬁ MSTest Test Project (NET Core)

A project that contains MSTest unit tests that can run on .NET Core on Windows,

Linux and MacOS.

Back Next

caly zestaw projektéw (to moze dowolny rodzaj projektu, przygotowany w dowolnym
jezyku wspierwanym przez VS), ktére tacznie stuza do rozwigzania danego problemu pro-
gramistycznego. Po podaniu wszystkich wymaganych informacji, przyciskamy przycisk

”Create” 1 czekamy na utworzenie projektu.

Utworzony projekt jest bardzo prosta, aczkolwiek w petni dzialajaca aplikacja, wy-
Swietlajaca w konsoli komunikat "Hello World from F# !":

// Learn more about F# at http://fsharp.org

open System

[<EntryPoint>]
let main argv =
printfn "Hello World from F#!"
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o X

Configure your new project

Console App (.NET Core) F#  Windows  Linux  macOS  Console
Project name
ConsoleApp1
Location
B
C\Users\tukasz Bartczukisource\repos
Solution name @
ConsoleApp1
[Z] prace solution and project in the same directory
Back Creat
I 0 // return an integer exit code

Caly program sktada si¢ z jednej funkcji main, ktéra stanowi punkt wejScia do aplikacji
(jest to pierwsza i w tym konkretnym przypadku jedyna funkcja uruchamiana w aplikacji)
6

Aby ja uruchomic, nalezy wcisna¢ przycisk FS (uruchamianie w trybie debugowania)
lub F6 (uruchomienie bez debugowania).

Utworzenie aplikacji sktadajacej si¢ z jednego pliku nie stanowi w F# zadnego pro-
blemu funkcje i inne elementy aplikacji mozemy wpisywac bezposrednio do tego pliku.
Musimy jednak pamigtac, ze dowolny symbol musi by¢ zdefniowany przed jego wykorzy-
staniem. Przyktadowo:

// Learn more about F# at http://fsharp.org
open System
let wyswietlKomunikat () = printfn "Ala ma kota"

[<EntryPoint>]

let main argv =
printfn "Hello World from F#!"
wyswietlKomunikat ()

0 // return an integer exit code

Sprawa si¢ jednak troch¢ komplikuje w przypadku, gdy mamy aplikacj¢ sktadajaca si¢
z kilku plikéw. Dodatkowe pliki mozemy dotacza¢ do aplikacji np. poprzez kliknigcie pra-
wym przyciskiem myszy na nazwie projektu w oknie Solution Explorer i wybranie z menu

®Nazwa main jest zwyczajowa i pozostata jeszcze po jezyku C++. W F# punkt wejscia do aplikacji moze
mie¢ dowolng nazwe. Istotne jest aby funkcja ta byta oznaczona atrybutem [<EntryPoint>]
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kontekstowego opcji Add/New Item. W wySwietlonym oknie dialogowym wybieramy
opcje “Source File”, a w okienku "Name” podajemy nazwe nowego pliku:

therForecastController s

Add New ltem - ConsoleApp1 ?

o

B soueerie
=

BT sorourerie
[ sewimrie
B recre

D) e

isual F# tems

isual F# Items

isual F# Items

isual F# Items

isual F# Items

ual F# Items

Vi
Vi
Vi
Vi
Vi
Vist
Vi

[yCuteshiteA isual F# Items

ShiftsAlLsA

ciex.
Del
=

sta))))

Team Exp... Class View Notificati Name: FlleLk:

Add Cancel

Rysunek 1.4: Dodawanie nowego pliku Zrédtowego do aplikacji F#

Musimy jednak pamigtaé, ze pliki aplikacji F# w Visual Studio sa kompilowane w
kolejnosci ich wystepowania w oknie Solution Explorer. Dlatego jezeli mamy dwa pliki
np. "program.fséraz "funkcje.fs"i w pierwszym pliku chcemy si¢ odwotaé do funkcji
zdefiniowanych w drugim musza one wystgpowaé w kolejnosci: najpierw "funkcje.fs", po-
tem "program.fs". Plik zawierajacy punkt wejScia do aplikacji musi by¢ ostatnim plikiem
w projekcie. Aby utatwié zarzadzanie projektem w menu kontekstowym okna Solution
Explorer mozemy przesuwac pliki w gére lub w dét (oczywiscie aby wySwietli¢ to menu
musimy kliknaé prawym przyciskiem myszy, na nazwie pliku, ktérego pozycje chcemy
zmieni¢). Zwré¢my uwage, ze w tym menu wystepuja réwniez opcje umozliwiajace doda-

- - T E
“iE @8 o-588 [u L=

T | Search Solution

srer (Ct P~
31 Solution Tutorial1’ (4 of 4 projects)
4 [ ConsoleApp1
> 58 Dependencies
T Fuzzy.fsx
[ funkge.fs
@ Open F* Program.fs ¥
Open With « [@ Test
Add Above , P & Dependencies
b c* Program.cs
Add Below
« [ Tutorial1
Code Cleanup » 4 5% Dependencies
b =m Assemblies
D '@ Packages
LT Scripti.fsx
Scope to This LT Tutorialfsx
> ] WebApplicationt

1 MoveUp Alt+Up Arrow

¥ Move Down Alt+Down Arrow

51 New Solution Explorer View

el

Exclude From Project

X cut Ctrl+X
[} Copy Cirl+C
X Delete Del
] Rename 2

1 Copy Full Path
Open Containing Folder

=%

A Properties Alt+Enter

Rysunek 1.5: Menu kontekstowe umozliwiajace zarzadzenie projektem aplikacji F#

wanie nowego elementu aplikacji przed ("Add Above”) lub po ("Add Below”) wybranym
pliku.
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W przypadku tworzenia aplikacji sktadajacej si¢ z wielu plikéw nalezy pamigtac o
jeszcze jednym bardzo waznym fakcie. Kazdy plik musi rozpoczynac si¢ od deklara-
cji modutu lub przestrzeni nazw 7. Jezeli aplikacje tworzymy w Visual Studio i nowy
plik do aplikacji dodaliSmy w sposdb opisany powyzej, to odpowiednia deklaracja jest
automatycznie dodawana przez Srodowisko. Przyktadowo:

module Funkcje

let wyswietlKomunikat () = printfn "Ala ma kota"
Listing 1.1: Zawarto$¢ pliku funkcje.fs

Jezeli nastgpnie do takiej funkcji bedziemy chcieli odnie$¢ si¢ w innym pliku np.
“Program.fs”, to taki modut musimy najpierw otworzy¢ za pomocg instrukcji open:

// Learn more about F# at http://fsharp.org
open System
open Funkcje

[<EntryPoint>]
let wejscie argv =

printfn "Hello World from F#!"
wyswietlKomunikat ()

0 // return an integer exit code

Listing 1.2: Zawarto$¢ pliku Program.fs

Gtéwnym zadaniem modutéw jest porzadkowanie naszego kodu oraz dbanie o to, aby
w aplikacji nie wystgpowaly konflikty nazw. Moze si¢ jednak zdarzy¢, ze r6zne moduty,
z ktérych musimy skorzysta¢, beda zawieraly np. funkcje o takich samych nazwach. W
takim przypadku wywotana zostanie funkcja z ostatniego otwartego modutu. Jezeli jednak,
bedziemy potrzebowali odwota¢ si¢ do funkcji w innym module, mozemy to zrobi¢ za
pomoca jej pelnej nazwy sktadajacej si¢ z nazwy modutu oraz funkcji np.

// Learn more about F# at http://fsharp.org
open System

[<EntryPoint>]
let wejscie argv =

printfn "Hello World from F#!"
Funkcje.wyswietlKomunikat ()

0 // return an integer exit code

Listing 1.3: Zawarto$¢ pliku Program.fs

"Nazwy modutéw oraz przestrzeni nazw zwyczajowo podajemy w notacji Pascal, tzn. Pierwsza litera
kazdego wyrazu w nazwie jest duza
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F# Interactive

Visual Studio jest wyposazone w bardzo ciekawe narzgdzie o nazwie F# Interactive. Jest

to interpreter jezyka F# dziatajacy w formie aplikacji REPL (Read Eval Print Loop). Czyli
mozemy w nim wydawaé komendy jezyka F# , ktére natychmiast zostana wykonane. Jest
to bardzo wygodne narzedzie, ktére mozna wykorzysta¢ do sprawdzenia sposobu dziatania
danego fragmentu kodu, bez potrzeby kompilowania i uruchamiania catej aplikacji. Mozna
je otworzy¢ z menu View>Other Windows>F# Interactive:

5 of the F# language.

ighlight a section of code and press Alt-Enter
4 can open the F# Interactive Window from the "

:/articles/fsharp/

) see:
:/articles/fsharp/tour

, use

Extensions and Updates' --> “Online’ and search

caew,p

1al templates to use with F#, see the 'Online Templates' in Visual Studio,
1 *New Project’ --> 'Online Templates’
b0 € > 4

1 e cur Properies Solion. |TeamExp.. CiassView Notifca

Rysunek 1.6: WysSwietlenie okna F# Interactive

Spowoduje to wysSwietlenie w dolnej czgsci ekranu okna:

F# Interactive v B X

Microsoft (R) F# Interactive, wersja 11.0.0.8 dla jezyka F# 5.0
Copyright (C) Microsoft Corporation. Wszelkie prawa zastrzezone.

Aby uzyskac pomoc, wpisz #help;;

> |

Ln:7 Ch:3  TABS MIXED

Rysunek 1.7: Okna F# Interactive

w ktérym mozemy podawac instrukcje jezyka F# . WigkszoS¢ instrukcji F# beda
sktadaty si¢ z wielu linii, dlatego klawisz “Enter” spowoduje w tym przypadku przejscie
do nastepne;j linii kodu. Aby wpisany kod zostal przetworzony przez interpreter nalezy
zakonczy¢ go podwdjnym Srednikiem ’;;’.

Jezeli kod funkcji mamy wpisany do pliku aplikacji, nie musimy go przepisywac
do interpretera. Wystarczy go zaznaczyC (albo za pomoca myszy, albo strzatkami z
wcisnietym klawiszem SHIFT) i nacisna¢ kombinacje klawiszy LEWY ALT+ENTER.

Kazda, nawet wieloliniowa instrukcja wprowadzona do interpretera jest traktowana
podczas wykonania jako jedna cato$¢. Niestety od strony edycyjnej kazda linijka kodu jest
osobng jednostka. Co powoduje, ze jezeli chcemy co§ w tym kodzie zmieni¢ konieczne jest
jego ponowne wprowadzanie. Jednoczesnie najczesciej nie chcemy, aby kod wpisywany
do interpretera stanowit czeS¢ aplikacji. Ponadto, w oknie tym nie mozemy korzystac z
podpowiedzi IntelliSense.
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Aby te dwa wymagania pogodzi¢ w Visual Studio wprowadzono nowy rodzaj pliku dla
aplikacji F# — Script File. Ma on rozszerzenie .fsx 1 jego zawarto$¢ moze by¢ wykonana
tylko w interpreterze (pliki te nie sa uwzgledniane podczas kompilowania aplikacji).
Mozemy w nim wprowadzaé dowolng zawarto$¢ F# i dowolnie ja edytowac oraz korzystaé
w pehi z podpowiedzi IntelliSense. Jednoczes$nie zawarty w skrypcie kod mozemy
uruchomié tylko poprzez jego zaznaczenie i wystanie do interpretera, poprzez wcisnigcie
kombinacji klawiszy LEWY ALT+ENTER.

Visual Studio Core

Jezeli z jakichS wzgledéw ktoS nie chee lub nie ma mozliwosci korzysta¢ z Visual Studio,
aplikacje F# moze stworzy¢ w dowolnym edytorze. W tym celu nalezy zainstalowac
platform¢ .NET Core. Wraz z platformg zainstalowane zostanag wymagane narzedzia,
przede wszystkim polecenie dotnet, ktére stuzy m.in. do utworzenia, kompilowania oraz
uruchomienia aplikacji.

W celu utworzenia aplikacji nalezy:

1. utworzy¢ dla niej katalog

2. uruchomi¢ konsole

3. przejs¢ do utworzonego katalogu

4. wydac polecenie dotnew new console -lang F#
Opcja console okresla typ aplikacji, ktérg chcemy utworzy¢. Oprécz niej mamy jeszcze do
dyspozycji nastgpujace rodzaje aplikacji:

Szablon Nazwa
Console Application console
Class library classlib
Worker Service worker
Unit Test Project mstest
NUnit 3 Test Project nunit
NUnit 3 Test Item nunit-test
xUnit Test Project Xunit
ASP.NET Core Empty web
ASP.NET Core Web App (Model-View-Controller) mvc
ASP.NET Core Web API webapi

Wykorzystanie opcji -lang jest w tym przypadku obowiazkowe, poniewaz domyS§lnie
wszystkie projekty sa tworzone w jezyku C#.

Budowanie projektu odbywa si¢ za pomoca polecenia dotnet build, a jego urucho-
mienie za pomocg dotnet run. Oczywiscie oba te polecenia mozna wydac bedac w
katalogu aplikacji (tym w ktérym znajduje si¢ plik projektu z rozszerzeniem .fsproj).

Dodatkowo z poziomu konsoli, za pomocg polecenia dotnet fsi mozemy réwniez
uruchomic€ interpreter F# .

Mamy teraz mozliwo$¢ tworzenia aplikacji F# nawet w Notatniku. OczywiScie nie jest
to zbyt wygodne narzgdzie. Zdecydowanie lepszym wyborem jest np. Visual Studio Code.
Jest to w petni darmowy edytor kodu. Mozna go uruchomi¢ zaréwno w systemie Windows,
jak rowniez w Linux-ie oraz na macOS. Dzigki mechanizmowi rozszerzefi mozemy w tym
narzedziu tworzy€ aplikacje ale praktycznie w dowolnym jezyku programowania, nie tylko
wspieranych przez Microsoft.
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W celu wygodnego korzystania z Visual Studio Code podczas tworzenia aplikacji F# ,
konieczne jest zainstalowanie dodatku Ionide-fsharp. Aby to zrobi€ nalezy:
1. uruchomi¢ Visual Studio Code
2. z toolbar-a znajdujacego si¢ po prawej stronie wybrac ikone rynku z dodatkami
3. w wySwietlonym oknie wpisa¢ nazwe dodatku, ktéry chcemy zainstalowac: Ionide-
fsharp
4. po wybraniu dodatku z listy klikna¢ przycisk “install”

Vew Go fun Teminal ke Extersion loide fsharp Visual st Code - o8 x

lonide-fsharp

lonide | @ 226

Requirements

Rysunek 1.8: Instalacja dodatku Ionide-fsharp w Visual Studio Code

Mozemy teraz tworzyC aplikacje F# , jednak nadal musimy recznie wpisywaé komendy
polecenia dotnet. Mozemy to zrobié poprzez wbudowany w Visual Studio Code terminal,
ktéry uruchamiamy z menu View>Terminal lub Terminal>New Terminal.

Dodatek Ionide-fsharp daje nam dostep do podSwietlania sktadni F# , podpowiedzi
IntelliSense oraz interpretera F# (wystarczy zaznaczy¢ fragment, ktéry chcemy wystaé do
itnerpretera i wcisnaé kombinacje klawiszy LEWY ALT+ENTER)

1 [let-f-a-bs=:ath;j;
2 f:12:34;;

Rysunek 1.9: Interpreter F# w Visual Studio Code

1.10.4 Wykorzystnie narzedzi online

Jezeli ktos$ nie chce instalowac platformy .NET, do tworzenia aplikacji w F# moze sko-
rzysta¢ z jednego z wielu narzedzi dostepnych poprzez przegladarke internetowa. Takie
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interpretery i kompilatory online sa dostgpne pod adresami np. https://try.fsharp.org/,
https://fable.io/repl/, https://repl.it/languages/fsharp.

Zadania

Tworzenie prostych funkciji

Zadanie 1.1 Napisz funkcje obliczajaca pole kota

Zadanie 1.2 Napisz funkcje wyznaczajaca wartoS¢ pierwiastkow rownania kwadratowego
Zadanie 1.3 Napisz funkcje, ktéra sprawdzi czy z trzech podanych wartosci rzeczywi-
stych, da si¢ zbudowac tréjkat.

Zadanie 1.4 Napisz funkcje, ktéra obliczy pole tréjkata, na podstawie dtugosci jego bo-
kéw. Jezeli z podanych wartosci nie da si¢ zbudowadé tréjkata rzué wyjatek z odpowiednig
wiadomoscia.

Rekurencja

Zadanie 1.5 Napisz funkcje, ktora rekurencyjnie oblicza sume n pierwszych liczb natu-
ralnych

Zadanie 1.6 Napisz funkcje, ktéra rekurencyjnie wyznaczy wartos$¢ x”, gdzie x i n sa
dowolnymi liczbami naturalnymi.

Zadanie 1.7 Napisz funkcje, wyznaczajaca wartoS¢ n-tego elementu ciggu fibbonaciego
Zadanie 1.8 Napisz funkcje, ktéra dla dowolnych liczb catkowitych n i k obliczy wartos¢

dwumianu Newtona: (, " zdefiniowanego w sposdb rekurencyjny:
k= g p yjny

1 dlak=0

(Z)Z 1 dlak=n
"N+ (2 dlak#0in £k

Zadanie 1.9 Napisz funkcje, ktéra rekurencyjnie sprawdza, czy dana liczba jest liczba
pierwsza.

Zadanie 1.10 Napisz funkcje, ktéra na podstawie 1000 rzutéw kostka do gry okresli
prawdopodobienstwo wyrzucenia szostki

Zadanie 1.11 Napisz funkcje, ktéra na podstawie 1000 rzutéw dwiema kostkami do gry
okresli prawdopodobienstwo wyrzucenia dwéch szostek

Zadanie 1.12 Napisz funkcj¢ okreslajaca najwigkszy wspdlny dzielnik

Zadanie 1.13 Oblicz przyblizong wartoS¢ szeregu nieskonczonego. Zatrzymaj obliczenia
kiedy wartoS¢ bezwzgledna kolejnego elementu w szeregu bedzie mniejsza niz ustalona
doktadnosé e (np. e = 1077):

L Y3
=1

2. ¢
i=1

3.y o
P i(i+1)

4. ¥ LY

Zadanie 1.14 Napisz powyzsze funkcje z wykorzystaniem rekurencji ogonowej
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Jednosteki miary
Zadanie 1.15 Napisz funkcj¢ zamieniajaca termperaturg wyrazona w stopniach Celsjusza
na temperature wyrazong w stopniach Fahrenheita zgodnie z ponizszym wzorem:

9
TFahrenheit =32+ g : TCelsius

Zdefiniuj wymagane jednostki miary oraz odpowiedni konwerter.
Zadanie 1.16 Napisz funkcje dokonujaca odwrotnej transformac;ji.

tancuchy znakéw

Zadanie 1.17 Napisz funkcje, ktéra sprawdzi czy dane stowo jest palindromem
Zadanie 1.18 Napisz funkcje, ktora policzy ile razy w podanym tekScie wystapil okre-
Slony znak

Zadanie 1.19 Napisz funkcje, ktéra okresli liczbe wyrazéw w podanym tekscie
Zadanie 1.20 Napisz funkcje, ktéra okresli liczbe cyfr wystepujacych pod rzad w tekscie.

Tworzenie aplikaciji

Zadanie 1.21 Napisz aplikacje¢ konsolowa, ktéry pozwoli uzytkownikowi na wprowadze-
nie imienia i nazwiska i wySwietli komunikat "Witaj <imie i nazwisko>"

Zadanie 1.22 Napisz aplikacje konsolowa, ktéry pozwoli uzytkownikowi na wprowa-
dzenie roku. W odpowiedzi program powinien wyswietli¢ informacje czy jest to rok
przestepny czy nie.

Zadanie 1.23 Napisz aplikacje konsolowa, ktéra na podstawie podanych uzytkownika 3
liczb rzeczywistych wyswietli na ekranie komunikat, czy da si¢ z nich utworzy¢ tréjkat
réwnoboczny, rownoramienny, prostokatny, dowolny inny lub ze z podanych wartoSci nie
da si¢ utworzy¢ tréjkata.

Zadanie 1.24 Napisz aplikacje konsolowa, ktéra przyjmie od uzytkownika ciag 11 cyfr.
Sprawdz, czy cyfry te tworzg poprawny numer PESEL, oraz na jego podstawie wySwietl
informacje o dacie urodzenia danej osoby oraz czy jest to kobieta czy mezczyzna.
Zadanie 1.25 Napisz aplikacje konsolowa, ktéra przyjmie od uzytkownika dowolny tekst,
1 wySwietli go zakodowanego zgodnie z szyfrem Cezara

Zadanie 1.26 Napisz aplikacje¢ konsolowa, ktora przyjmie od uzytkownika dowolny tekst
zakodowany zgodnie z szyfrem Cezara, i odkoduje go.

Zadanie 1.27 Napisz aplikacje konsolowa, ktéra wezytuje liczbe catkowitg okreSlajaca
liczbe minut od pétnocy. Program powinien wyswietla¢ w odpowiedzi konkretng godzing,
ktéra bedzie odpowiadac tej liczbie. Jezeli podana liczba godzin bgdzie przekraczata liczbe
godzin wciggu doby na ekranie powinien pojawic si¢ stosowny komunikat

Zadanie 1.28 Napisz aplikacje konsolowa, ktéra wezytuje liczbe catkowitg okreslajaca
liczbg minut do startu. Program w odpowiedzi powinien wySswietla¢c komunikaty: "do
startu pozostato ... minut". Jezeli odliczanie dojdzie do zera powinien wyswietli¢ si¢
odpowiedni komunikat. Odpowiednia funkcje prosze umiesci¢ w osobnym pliku.
Zadanie 1.29 Napisz aplikacje konsolowa, ktéra rozwiazuje problem Collatza. Pro-
gram powinien wczytywac od uzytkownika liczbe catkowita dodatnig. Na jej podstawie
obliczamy kolejne wartosci:

Cooi = 0.5%xC, jezeli C,, jest parzysta
T 34 C,+1 w przeciwnym przypadku



34 Rozdziat 1. Podstawy programowania w jezyku F#

gdzie Cy jest wartoScig wprowadzong przez uzytkownika. Przypuszcza sig, ze od nie wazne
od jakiej liczby zaczniemy, to osiagniemy wartos¢ 0.

Napisz program, ktéry wyswietli kolejne wyrazy tego ciagu wraz z ich numerem. Np.
jezeli zaczniemy od wartosSci 5 na ekranie powinniSmy zobaczyc¢:

1.5
2. 16
3.8
4. 4
5.3

6. 1
Zadanie 1.30 Napisz aplikacje konsolowa, ktéra pozwoli na wezytywanie z klawiatury
liczb catkowitych. Oblicz Srednig tych liczb. Uzytkownik powinien wprowadzaé wartoSci
dopdki nie poda wartosci ujemnej. Odpowiednia funkcj¢ prosze umiesci¢c w osobnym
pliku.



